Step #1 Prior to Entering Data in SASI, print these reports!

· Open Sections
· Choose the MST02 or MST09
MST 02
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MST09
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· Sort by course, or Teacher name, your preference
· Click on Preview first and Preview button to see if you like the SORT conditions you have chosen….then print later!
OR
Additional Step #1 

How to print a list of sections after you finish entering a grade to verify teacher’s name, maximum class size
· Open Sections
· Click on the magnifying glass [remember it clears the screen!]
· Click in Lo and Hi and put in the grade you want to pull up 
· You will have a matrix of all classes, by SectionID, Beg End periods, etc. it will automatically sort by Section ID number (everything is number, number!), but if you want it to sort by the teacher name before you print it out, then double-click on the heading TeacherName and then File, Print.  You may have to change your page setup to Landscape to print!
HOW TO MAKE A DATA ATOM FROM A MATRIX
How to make a Data Atom with specific students [i.e. Special Education Students, 1st grade]
· Open the Student Atom

· Click the Magnifying glass F (to clear the screen)

· Chose grade level, i.e. 05

· You may want to choose an Instructional Setting, i.e. S

· Click Find (you now have a matrix of students to work with
· Hold the Shift Key and click on the student’s name for the “group” you wish to schedule for the sections.

· Click and Hold under the StudentID field, drag to your desktop 

· Close everything 

· Click once on the atom you have just made (it needs to be renamed)
· File, Atom Info

· Name the Atom ~ Ms. Smith’s 1st grade Homeroom and Enter a Description
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NOTE: If you place your cursor on the atom without opening it, you will be able to see what the atom will do without opening it, so be specific.

[image: image4.png]M. Smith's 01 class.

Query





HOW TO MAKE A SECTION ~ 2 WAYS ~ New or Duplicate

How to add a section in SASI
· Basic Scheduling Folder

· Open Sections Atom

· Gray menu bar, Data, Add Section 

· Enter Beginning Period TAB or click 

· Enter Ending Period TAB

· Term (YR)

· Lo (Drop Down – select appropriate grade level)

· High (Drop Down – select appropriate grade level)

· Max - # of students in class (Refer to the current State Maximum chart)

· Enter the course number (you may key it or drag and drop it from Course List), TAB

· The Course Title will appear – verify it’s the right one!

· Room number 
· Teacher number (Key it and TAB, or drag and drop from Teacher List)

· Add the SectionID after the “ – “ dash in the top left (first) field, i.e. 01, 02, etc.  SAVE.  This step must come last, or you will get an error and cause SASI to close.

note:  if you click save and receive this message:
error:  cannot add or update section with an incomplete or blank Section id.

click ok. go back and do the last step – you just forgot to do it. 

NEXT, [note: you must save the section before you can do this step] select the MEETING DAYS (Art, Music, and Health only meet 1 day each; PE 2 day—this may change based on each school’s decision) if class meets less than 5 days per week.

Click on the bottom left hand corner, next to “Student List” and drag to “Meeting Days”.

For Meeting Days that are not M, T, W, R, F, you must change here.  Click in the white “begin period” under the day of the week the class will not meet to blank out the period.  Then SAVE.  Repeat for other non-meeting days.

IF you are working with the same Course number, you may DUPLICATE the section.

· Gray Menu Bar, Sections, drag to the bottom of the list, select Duplicate Section.

· Start with Beginning Period and Ending Period. Verify or change it.

· Term should remain the same.

· Grade level should remain the same.

· Max students should remain the same.

· Change the Teacher number if necessary, and TAB to change the name.

· Go up and add the Section number, i.e. 01, 02, etc. Click SAVE.

· Go to Meeting Days if the class does not meet on the same days as the section you duplicated from.

How to Print Continuous schedules for a specific grade in order to verify the periods, meeting days, etc., or how to print schedules for a specific group, i.e. special needs. 

· Open Student atom 

· Click on Student at the gray menu bar at the top of the screen

· Drag to STU07 
· The STU07 will print continuous schedules

· Need a specific grade?  If so, click in the box and choose the grade OR

· If not for a specific grade leave BLANK

· Click on the Custom button

· Type the following in the blank/white query condition field:

· InstrSet = “S” if you want Special Ed Students
· Want to print only Inactive Students [maybe you gave the students a schedule and now they are not returning]

· Type the following in the blank/white query condition field:

· Status <> “ “ 
· Click PRINT

Assigning Classes to All Students using Sections

Assign students to a homeroom using drag and drop:

1. Using Query, create a “KEEP” filter for each grade level (example, 4th Grade)

· KEEP ASTU IF Grade =04; SAVE Filter

· Atom Info ~ Name GRADE 04; Click OK

· The Filter will automatically be placed in the System Filter Folder on your desktop.  

2. Make a folder named Filters and put all of the grade level filters in it.  When working with grade 04, place the Grade 04 filter in the System Filter.

3. Launch the Student Atom, place an * in the Student Name field and drag to 04 in the Grade field.  A matrix will appear.
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Choose the students for grade 04 Homeroom by highlighting the names from the Matrix (student atom) or clicking on specific names in the left hand column of the Generic Selection atom to move them to the right hand column.  Once the names are highlighted in the Matrix, click in the middle of the names under the StudentID column and drag to the desktop.  

Or launch Generic Selection in the Utilities folder.
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For Generic Selection, hold down the shift key and click the word “selection.” Click anywhere in the list of names and drag them to the desktop.

4. Close everything on your desktop.  Highlight the atom, go to File/Atom Info and name the atom; i.e. HR01-02.

5. Continue the process until all Grade 04 students have been placed in a Homeroom.

6. The Homeroom atoms may be used to schedule the other sections, Math, Lang Arts, Reading, etc., and then exceptions can be handled on an individual basis. (School based decision)

Assign students to their classes using the Homeroom atoms

1. Launch the Sections atom.  Perform a “Find” by typing the Teacher number into the field “TCH#” for the teacher you want to populate the Sections with the students.  All Sections for this teacher number will appear.
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2. Double-click on the Homeroom (example, Fourth Grade) to open the Section.

3. Drag the Homeroom Atom for the students in the first Grade 04 (04-01) atom onto the section to place the students into the class.
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NOTE:  Does your school issue grades for Homeroom, maybe conduct only?  If not, be sure to Exclude from Grading.
4. Close that class.

5. Double click on the next class and drag the next homeroom atom onto it and close it. Continue with the other classes for that specific teacher if you have been given the teacher’s schedule for the core and “special” classes. 

6. Continue the process until all Grade 04 students have been placed in their classes. (04-02, 04-03, etc.)
7. Perform the same routine on all grade level students and all grade level classes.

Manual Procedure  to schedule  classes by entering section number
1. Launch the CLASSES ATOM and bring up the record for the student.

2. From the Data menu, select Add Classes.
3. Enter the SectionID for the section to be added.

NOTE:  The start date will default to today’s date. To change the start date, select Show Start Date from the Classes Menu, click in the scroll bar to display the Start Date field or tab to it, and enter the new start date.

4.  Click “SAVE” to save your entries (click Undo to erase all new entries).
To remove  a class (scheduled in error) from a student’s Class list:

1. Launch the CLASSES ATOM (Basic Scheduling Folder) and bring up the record for the student you are changing.

2. Highlight the class you want to remove (or delete) from this student by clicking the line number cell.

3. From the “Data” menu, select Delete Classes.
4. A pop-up box is displayed.  “Enter” the drop date for the class. 
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5. The drop date cannot be the same as the start date for the new class.

6. “Click” the appropriate checkbox to indicate whether you want to create a history record for the dropped class. If the student has been taught by teacher and was not scheduled in error, then the class must be dropped with the dropped date.  Do not check the box “Include in upcoming grade report.”

7. Click “Save” to save the changes (click Cancel to quit without saving the change).

TO FIND STUDENTS MISSING A SCHEDULE
Reports or query?

Query:

DISPLAY ASTU ACLS 1,StuLink PermNum LastName FirstName Grade IF 2, Stulink = 0    Be sure to “Darken Show Empty Records”
Reports:

CLS19 Less than Full and CLS20 More than Full – enter the number of periods your school is using; if each grade level has different number of periods scheduled, click CUSTOM, enter Grade = “02” (“if” condition is not necessary)

How to Query & Print a matrix showing the meeting days horizontally’
· Open the Utilities Folder; click on Query 
DISPLAY AMST ASTU InstrSet SectionID CrsTitle TchName UF {M=SplitBeg[0]} {T=SplitBeg[1]} {W=SplitBeg[2]} {R=SplitBeg[3]} {F=SplitBeg[4]} IF InstrSet = “S”

NOTE:  The matrix will have M T W R F horizontally and then the period will be under the day with the teacher’s name.  
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Assigning classes to a new student or changing a current student’s class schedule using the Classes Atom
To assign Sections to a student using drag and drop:

You can do “all” Sections at once or make a Keep Filter for a specific grade level. If you want only Grade 4 in the Sections the query is as follows or click Lo 04 to Hi 04 in the Sections when performing a “find.” 

KEEP AMST Status IF Lowgrdrest = 04

Next, launch the SECTIONS ATOM.  Perform a “Find” clicking on the magnifying glass and typing an * in the SectionID field and pressing enter. Hold down the shift key and highlight the classes you want to use for scheduling in the Classes atom for each student.    
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Click on one of the SectionID’s that is highlighted and drag and drop to the desktop –BEING CAREFUL TO CLICK ON THE SECTION ID WHEN DRAGGING.  (To verify the data atom is correct, double click the atom).   Close SECTIONS. From the “File” menu, choose Atom Info and rename the atom to reflect the teacher name, (and anything you want to identify the atom, i.e. 4th Grade, Smith HR.)
NOTE:  If you do not close everything on your desktop prior to renaming the atom, you could rename the Sections Atom inadvertently.

1. Launch the CLASSES ATOM and bring up the record for the student.

2. Drag and drop the HR atom on Classes from that is displayed.

NOTE: The start date will default to today’s date. To change the start date, select Show Start Date from the Classes Menu, click in the scroll bar to display the Start Date field or tab to it, and enter the new start date.

3. Click “SAVE” to save the student’s classes record. (Click “Undo” to erase any changes you have made.)

NOTE:  You can add sections to a student’s record (Classes screen) one at a time from the SECTIONS matrix list, if desired.  

What if there is already a student scheduled that will have an identical schedule as a new student who is enrolling?  

Open the Classes atom, Find the student with the schedule, hold down the shift key and click on LN to highlight all.
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Open the Classes Atom again, Find the NEW Student, click, drag and drop the classes to the New Student’s Classes screen.
Place cursor on Atom
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